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Monthly Reminders:
e Run Disk Cleanup
® Run CC Cleaner

¢ Defrag your hard drive

e Manually Update Win-
dows

e Update Malware Bytes

® Run your Anti-virus
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Shut down at night?

Would it be better to
shut the computer
down after I'm done
with it for the day or
keep it on 24/7? Every-
one seems to have a
different opinion and
I’m not sure who to
believe!

The argument over
leaving a computer run
or shutting it down
when not in use is a
long running one. One
camp says that running
a computer 24/7 mini-
mizes the stress on the
computer as the startup
sequence (spinning up
the drives, power up
the boards) is the most
stressful on the com-
puter. The other camp
says that it’s a waste of
electricity to run a
computer around the
clock.

The reality is they’re
both right but one camp
is far more practical.
Yes, shutting down a
computer and starting it
up places more stress
on a hardware than
leaving it running for-
ever. The most likely

component to fail
prematurely is the hard
drive. A perfectly good
hard drive of a large
capacity (750GB-1TB)
runs about $50 at the
time of this writing.
Bear that in mind as we
look at the cost of run-
ning a computer 24/7.
On the other side of the
coin, shutting down a
computer when it’s not
in use saves you a boat-
load of cash. Let’s say
you’ve got a pretty
standard off the shelf
computer that con-
sumes 300-400w of
energy when every-
thing is on. Let’s say
you use that computer
12 hours a day and turn
it off for 12 hours. In
turning it off for half
the day (probably long-
er when you factor in
days you aren’t using
the computer heavily,
holidays, etc.) you’re
saving hundreds of dol-
lars a year, easily.
More than enough to
replace quite a few
components if they
should wear out prema-

turely (which is highly
unlikely as computers
are engineered to be
turned on and off all
the time).

There are a few rea-
sons to leave a PC on
24/7, however. If
you’re participating in
any sort of distributed
computing project
(where your computer
is in use to say, fold
proteins or sequence
genes) you’ll want to
leave your computer on
to fully participate. Al-
so if you use a remote
backup service and
have a lot of data to
move the off hours are
a great time to do so.
Finally if we’re talking
about your work com-
puter you might want
to check with your IT
department and make
sure that the night shift
isn’t when they push
major updates and
backup files.



We could create
our own in
Base, but for a
simple address
book, Calc is an
easier solution.
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Libre Office Mail Merge

Up until now we have
been working in Li-
breOffice Writer, but
today we will step
away for just a second
to do something a little
different. We're going
to create a poor man's
database in Calc and
then return to Writer
and create a mail
merge. This will give
you some ideas about
how you can use a
spreadsheet as a data-
base. In order to do a
mail merge, we need to
work with some sort of
database.

We could create our
own in Base, but for a
simple address book,
Calc is an easier solu-
tion.

We will start by open-
ing LibreOffice and
clicking on Spread-
sheet. This will open
Calc with a blank
spreadsheet. We won't
go into a lot of details
about the layout of
Calc; we'll save that for
another day. What you
do need to know is that
a spreadsheet is

laid out as a series of
columns and rows. The
columns are labeled
above with letters
(A,B,C,...) and the rows
are down the left side
labeled with numbers
(1,2,3,...).

When we use Calc as
a database, the first

row must contain the
field titles for the data-
base. These are the
database field headers.
We will put the follow-
ing field headers in the
first row: Title, First
Name, Last Name,
Street Address, City,
State, Postal Code,
and Country.

Each field must be in a
separate column start-
ing at column A, so

put the cursor in col-
umn A of the first row
and type in Title. You
can use the right arrow
key on the keyboard to
move to the next col-
umn, and fill in the rest
of the fields.

Starting with the se-
cond row, we begin to
fill in our data. Each
row is a record. Think
of a record as all the
information on one per-
son. For our purposes
today, you don't need
to worry too much if the
data is wider than the
columns. If you want to
adjust the width of the
columns while you in-
put your information,
just place your mouse
over the line separating
the two columns. The
cursor will become a
double arrow, and you
can click and drag to
increase or decrease
the width of the col-
umn. Once we have
entered all our data,

we need to save the
spreadsheet. | saved
mine as Poor-
man_db.ods. Once it is
saved, close it.

Before we can use our
poor man's database,
we need to register it in
LibreOffice. File >
New > Database will
bring up the database
wizard. Select “connect
to an existing data-
base”, and in the drop-
down box, select
spreadsheet. Click the
Next button. Use the
Browse button to find
your spreadsheet.
Click Next.

Make sure “Yes, regis-
ter the database for
me” is selected, and
uncheck “Open data-
base for editing.” Click
Finish, and give the
database a name (I
named mine Address-
es).

The database you just
created is linked to the
spreadsheet. Any up-
dates you make to the
spreadsheet will show
in the database. The
only catch is you can-
not edit the spread-
sheet when you have
Writer opened.
Basically, your spread-
sheet database can be
the only LibreOffice
document open.
Otherwise, LibreOffice
will open the spread-
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Libre Office Mail Merge (ontinueq)

sheet in read-only
mode.

Now that we have cre-
ated our database, and
registered it in Li-
breOffice, we can use
it to create a mail-
merge. Mail-merge is
great for sending form
letters to customers or
prospects. The cool
thing is you can put
any kind of data you
want in your database
and then use it in the
letter. For example, if
you have a rewards
program for your cus-
tomers, you could have
a field for points, and
include the points each
customer has earned
in the letter, but you
would have to type the
letter only once.

Click on the Data
Sources icon or press
F4. This will display the
registered databases
below the formatting
toolbar. In the left part
of the data sources,
Addresses (or whatev-
er you named your da-
tabase) > Tables >
Sheet.

On the right side, you
will see your data laid
out much like you en-
tered it in the spread-
sheet. We insert the
fields into the docu-
ment by clicking on the
field header and drag-

ging it into the docu-
ment.

This will create a field
placeholder for every
field you drag into the
document. Make sure
you drag the field
header and not a data
block in a record.

Now, you can type the
body of your letter.
When you need a field
from the database in
your letter, you can
drag it into the docu-
ment.

The database fields
can be used any place
in the document. As |
said before, your data-
base can contain what-
ever information you
need it to contain. A
teacher could even use
it to report students'
grades in a letter to
parents.

Once you have fin-
ished typing your letter,
you can print or send
to a file. You might
want to send a letter to
file when you need to
go back and add per-
sonal information for
certain individuals. Like
a teacher might want to
request a parent-
teacher conference for
a student failing the
class. File > Print, just
like you would for a
normal document.
However, LibreOffice
will tell you that your
document contains ad-

dress database fields
and asks you if you
want to print a form
letter. Answer yes. The
Mail Merge dialog will
appear. In the dialog,
you can choose to print
to the printer or to a
file. Also, you can
choose to print a letter
only for selected rec-
ords or a range of rec-
ords. You select rec-
ords by clicking on the
gray box at the begin-
ning of the record, or
use CTRL-click to se-
lect only certain rec-
ords, or SHIFT-click to
select a series of rec-
ords. When you print to
a file, you can choose
to print to one file, in
which case each letter
will begin on a new
page, or save as indi-
vidual files, in which
case each letter should
have its own file. You
can select which data-
base field to use for the
file name. On my ver-
sion of LibreOffice
(3.3.3), I got one docu-
ment whichever |
chose.

Apparently, they are
still working on this fea-
ture.

You can also use your
database to generate
labels. File > New >
Labels opens the la-
bels dialog. Select your
database and table.
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The database
fields can be used
any place in the
document. As |
said before, your
database can
contain whatever
information you

need it to contain
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The wizard has
some
restrictions, and
when | tried to
use the wizard,
| found it more

difficult to get

good results.

Libre Office Mail Merge (continuea

Move the fields over
into the label infor-
mation box. Select
your label type and
click New Document.
As with the form let-
ters, when you get
ready to print, you will
have an opportunity to
select the records you
want to print, and you
can print to a printer or
a document.

You can also cre-
ate envelopes
much in the same
manner.

There is another
way to create a
form letter, using
the Mail Merge
Wizard: Tools >
Mail Merge Wiz-
ard. The wizard
has some re-
strictions, and
when | tried to
use the wizard,

| found it more
difficult to get
good results. |
found the manual
method | have de-

formation. In my next
article, we will start to
learn more

about Calc by creating
a simple budget
spreadsheet.

From Full Circle Maga-
zine Issue 5This story
can fit 150-200 words.

One benefit of using
your newsletter as a
promotional tool is that

you can reuse content
from other marketing

useful content to your
newsletter is to devel-
op and write your own
articles, or include a
calendar of upcoming
events or a special of-
fer that promotes a
new product.

You can also research
articles or find “filler”
articles by accessing
the World Wide Web.
You can write about a
variety of topics
but try to keep
your articles short.

Much of the con-
tent you put in
your newsletter
can also be used
for your Web site.
Microsoft Publish-
er offers a simple
way to convert
your newsletter to
a Web publication.
So, when you're
finished writing
your newsletter,
convert it to a Web
site and post it.

From Full Circle Maga-

scribed here to give materials, such as zine Issue 52
better results, giving press releases, market
’ studies, and reports.
the creator more con-
trol over the output. While your main goal
Mail merge is a great of distributing a news-
time saver. Bang out letter might be to sell
your letter, drop in your product or ser-
some database fields, vice, the key to a suc-
and print. Sure beats cessful newsletter is
typing 100s of letters or making it useful to your
manually editing each readers.
one to change the in- A great way to add
Page 4 SVECC Newsletter



Inside Story Headline

RoboForm is one of my fa-
vorite software programs as
it helps me very quickly log
into secured websites. My
listings of these websites
include airlines, email, finan-
cial, medical, stores, travel,
etc., and | currently have
more than 50 of these se-
cured websites listed.

The program is very easy to
use. For example, first open
Internet Explorer, and then
click on one of its little
toolbars titled RoboForm
and a list of several choices
appear titled Logins, Identi-
ties, and Soft Notes. While |
mentioned Internet Explorer,
RoboForm also works
equally as well with Firefox,
Safari, Chrome, and many
more browsers. Next,

| click on Logins and then
click again on the listed se-
cured website that | want to
enter. Next, RoboForm auto-
matically redirects Internet
Explorer to the website that |
selected and when the login
website appears, RoboForm
automatically fills in my
name and password, and
I’'m immediately logged into
the secured website with
unrestricted abilities.

Once you have the program
installed, when you go to a
new secured website and fill
in your user name and pass-
word and click on Enter,
RoboForm will automatically
add the information. Includ-
ing the website address, to
your list of Logins.

If you need a new password,
RoboForm will generate a
highly secure password. On

the Login list in RoboForm,
the secured websites are
listed alphabetically and you
can easily rename any list-

ing.

Other RoboForm features
include SafeNotes, which
securely stores other infor-
mation of your choice. For
example, some banks will
frequently ask you for your
wife’s favorite color, your
first dog’s name, etc., to
ensure that you are the se-
cured party attempting to
access your bank account,
etc. You can securely store
this information in Safe-
Notes.

"-'ﬁ_'—"—\.}‘

“[RebofForm

RoboForm’s options under
Logins include Edit, New,
and Print List. Under Identi-
ties are Edit, New, and Fill
Empty Fields Only. Safe-
Notes includes Edit, New,
Print to New, and Print Last.
Numerous other choices
include Fill Forms, Save
Forms, Fields — Reset, Sat,
and Clear, Profiles — De-
fault, New, Date, Name,
Refresh Fields, Explorer,
Tools — Edit Identify, Edit
Password, Edit SafeNotes,
Search Fields, Taskbar Icon,
Generate Password, and
Sign RoboForm data, and
Options — Help.

I've used RoboForm for nu-
merous years in Windows
XP, Windows Me, Windows
2000, Windows Vista, and
now Windows 7. Ro-
boForm’s website is
www.roboform.com, and
there are three versions of
RoboForm available: Desk-
top, Everywhere, and 2Go.

Desktop provides high secu-
rity and restricts the access
to RoboForm from only one
computer.

Everywhere allows you to
access RoboForm from nu-
merous computers.

2Go works using a portable

USB drive, so that
you can take your
RoboForm infor-
mation and use it
on many comput-
ers while traveling
on business or on
vacation.

RoboForm runs in
numerous ver-
sions of Internet
Explorer, including
versions 6, 7, 8, and 9 but
only on 32-bit versions and
not the 64-bit versions.
There is a free version of
RoboForm that is limited to
only 10 logins. For more
than 10 logins, the Every-
where version is available
for $20 per year, and the
Desktop version is $30. The
current version, which is
version 6.10.2.0, was intro-
duced earlier this year.

When you install RoboForm
for the first time, you will be
asked to create a master
password, which protects all
of your secured data in your
Logins, Identities, and Safe-
Notes. This prevents anyone
else who has access to your
computer from seeing or
copying this information. If
you prefer, you can elimi-
nate this protection and al-
low anyone to access all of
your important information.

Review: RoboForm

Program stores websites,
login information

By Jim Thornton, Member,
Channel Islands PCUG, CA

August 2011 issue, The Out-
er Edge

WWW.cipcug.org

Jasthorn (at) gmail.com

“To catch the
reader's attention,
place an interesting
sentence or quote

from the story here.”
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911 Call to help group
What it costs elsewhere
Geek Squad in home call $149.00 per hour
Serving Online Seniors in home call $85.00 per hour
On line help $79.95 subscription + $24.95 per month
a gratuity to your SVECC helper is recommended

Name Phone

Address

Brief problem description

Computer Help Group

Group Leader Joe Zagar

Joe Zagar

480-373-9373

all systems and programs

Depending on the season we have a number of helpers to assist with problems or
installations. Contact Joe Zagar for assistance, referral, or recommendation of local

service provider.

In addition on most Tuesdays from October to March we offer a fix-it session from

lpm to 3pm at the Training Center. Sessions are open to all residents of SVE and
are first come first serve. Charge is $15.00.

Call ahead to see if your problem can be solved at a Tuesday session.
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SUN MON TUE WED THU FRI SAT
1

2 3 4 5 6 7 8
Computer Club

9 10 11 Patch Tues |12 13 14 15
Computer Club SLUG 6pm ASU Auction

16 17 18 19 20 21 22
Computer Club

23 24 25 26 27 28 29
Computer Club | SLUG 6pm

30 31
Computer Club

Computer Tips
E-mail

* If you get a message from your bank or eBay about a problem with your account, it’s probably a
“phishing” scam. It’s a fake, designed to lure you into typing your name and password so the bad

guys can have it. Delete it. If you're concerned, visit the institution’s Web site in your browser by typ-
ing in its address (like Citibank.com) — not by clicking the link in e-mail.

Before you pass on any amazing item you get by e-mail—Obama’s a Muslim, the bubble boy wants
greeting cards, the Nieman-Marcus $400 cookie recipe — first check it out at Snopes.com, the world
clearinghouse for Internet scams and rumors.

If a blue underlined link shows up in an e-mail message, you can mouse over it without clicking to
see what Web site it plans to open.

* If you get a message from someone you know that relates a horror story about being mugged in
England (and needing you to wire money immediately), delete it. It's a popular scam — even if it's
the correct e-mail address of someone you know.
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People helping
People

Founded for the Residents of

Sunland Village East

Mission: To help each other learn about Computers

Membership is open to all residents of SVE

Dues are $20.00 per Year

Irish Story

Patton staggered home
very late after another
evening with his drinking
buddy, Paddy. He took off
his shoes to avoid waking
his wife, Kathleen .

He tiptoed as quietly as he
could toward the stairs
leading to their upstairs
bedroom, but misjudged
the bottom step. As he
caught himself by grab-
bing the banister, his body
swung around and he
landed heavily on his
rump. A whiskey bottle in
each back pocket broke
and made the landing es-
pecially painful.

Managing not to yell, Pat-
ton sprung up, pulled
down his pants, and
looked in the hall mirror to

Due October 1st

see that his butt cheeks

were cut and bleeding. He
managed to quietly find a
full box of Band-Aids and

began putting a Band-Aid
as best he could on each
place he saw blood.

He then hid the now al-
most empty Band-Aid box
and shuffled and stumbled
his way to bed.

In the morning, Patton
woke up with searing pain

in both his head and butt
and Kathleen staring at
him from across the room.

She said, 'You were drunk
again last night weren't
you?'

Patton said, 'Why you say
such a mean thing?'

'Well," Kathleen said, it
could be the open front
door, it could be the bro-
ken glass at the bottom of
the stairs, it could be the
drops of blood trailing
through the house, it
could be your bloodshot
eyes, but mostly ....... it's
all those Band-Aids stuck
on the hall mirror.



